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MapInfo Professional 11.5.4 
Release Notes

This document provides information on new and enhanced features that have been introduced 
into MapInfo Professional since version 11.5. It also contains sections on resolved customer 
issues and some remaining known issues that are important for users to be aware of.

MapInfo Professional 11.5.4 is a cumulative update that includes everything that was updated 
with 11.5.1, 11.5.2, 11.5.3 plus an additional critical fix.
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Before You Continue
This release upgrades 11.5, 11.5.1, 11.5.2, or 11.5.4 installations of MapInfo 
Professional to version 11.5.4. Follow the instructions provided in this document 
under Upgrading MapInfo Professional.
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Upgrading MapInfo Professional
Your computer must be connected to the Internet to download the 11.5.4 Maintenance Release.

You may upgrade using this Maintenance Release provided one of the following products is already installed:

• MapInfo Professional 11.5, 11.5.1, 11.5.2, or 11.5.3.
• MapInfo Professional Runtime 11.5, 11.5.1, 11.5.2, or 11.5.3.

If both of these products are installed, then the installer upgrades them at the same time. You do not need to run this 
installer multiple times.

To upgrade MapInfo Professional to version 11.5.4 Maintenance Release:

1. From the MapInfo Professional Main menu, select Help > Check for Update. The Maintenance Releases for 
MapInfo Professional web page displays.

2. On the web page, click the download link and follow your web browser's instructions for opening and running the 
patch file.
The file is called MapInfoProfessional11.5.4MaintenanceRelease.exe should you choose to save and run it later.

3. Follow the instructions to complete the upgrade. 

It is important to wait until the installation completes.

Advanced Upgrade for System Administrators
This section is for the system administrator installing this Maintenance Release using a command line, and the 
network system administrator installing this Maintenance Release across the network using a Microsoft Patch (MSP) 
file.

Upgrading in Silent Mode
To run the MapInfo Professional Maintenance Release installer in silent mode, from a command prompt change 
directories (cd command) to the Maintenance Release.exe file and then type:

MapInfoProfessional11.5.4MaintenanceRelease.exe /s /v"SILINST=True"

Where:

/s = runs the setup.exe silently.

/v = passes the parameter "SILINST=True" into the setup.exe to suppress the GUI.

A progress dialog box may display during the installation. 

Windows 7, Server 2008, and Server 2008 R2 users may see a prompt for permission to continue. Click Allow or OK 
to proceed. 

Upgrading Using a MSP File
The MSP file for the MapInfo Professional Maintenance Release only updates the English version of MapInfo 
Professional 11.5, or 11.5 that was upgraded to 11.5.1, 11.5.2, or 11.5.3. It does not update:

• MapInfo Professional Runtime
• MapInfo Professional 11.5.2 if it was a full release (new installation) or 11.5.3 if it was an upgrade from the 11.5.2 

full release.
If you have a new MapInfo Professional 11.5.2 installation (not an upgrade), then use the 
MapInfoProfessional11.5.4MaintenanceRelease.exe file to upgrade this installation.
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Before you begin, you will need:

• The MSP file, which is available on the web. To download, go to http://www.pbinsight.com/support/product-
downloads/item/mapinfo-professional-v11.5.4-maintenance-release-msp

On Windows 7, Server 2008, and Server 2008 R2, install this Maintenance Release with elevated privileges. To do 
this, right-click on the Command-Line Interpreter (cmd.exe) and select Run as Administrator from the popup menu, 
then continue with the following instructions.

Upgrading MapInfo Professional Software

To run the Maintenance Release installer MSP file, type:

msiexec /p <path to the MapInfoProfessional11.5.4MaintenanceRelease.msp file> 
REINSTALL=ALL REINSTALLMODE=omus 

Where:

/p = applies the latest patch.

On Windows 7, Server 2008, and Server 2008 R2, a prompt for permission to continue may display. Click Allow or 
Yes to proceed (if you do not respond and the message times-out, then the upgrade is unsuccessful).

You can upgrade silently by adding a silent parameter switch to the command, such as /qb, /qn, /qr, or /q. For example:

msiexec /p <path to the MapInfoProfessional11.5.4MaintenanceRelease.msp file> /qb 
REINSTALL=ALL REINSTALLMODE=omus 

Where:

/qb = to see a basic progress dialog box during the installation.

Maintenance Release 11.5.4
This section lists the updates made since the 11.5.3 release. The 11.5.4 Maintenance Release is cumulative and 
includes all updates supplied with the 11.5.1, 11.5.2, and 11.5.3 Maintenance Release.

This maintenance release fixes a critical issue that was introduced with the 11.5.3 release. If you have installed the 
MapInfo Professional 11.5.3 maintenance release, then update your release to 11.5.4 to ensure that you do not 
damage your existing workspaces.

Progress and Resolution of Outstanding Issues

Maintenance Release 11.5.3
This section lists the updates made since the 11.5.2 release. The 11.5.3 Maintenance Release is cumulative and 
includes all updates supplied with the 11.5.1 and 11.5.2 Maintenance Release.

• Support for MapInfo Manager 1.3.2
• Progress and Resolution of Outstanding Issues

Issue Number Description and Resolution

MIPRO-33945 MapInfo Professional may close unexpectedly when saving to a workspace if you have a map containing an SQL 
Select Query layer and the map is in a layout frame.

Resolution: Fixed. This release ensures that you do not lose any of your work.
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Support for MapInfo Manager 1.3.2
MapInfo Professional 11.5.2 had editing support with MapInfo Manager 1.3. In MapInfo Professional 11.5.3, you will 
now be able to edit metadata for the metadata profiles ISO 19139, UK Gemini, ANZLIC, and INSPIRE. MapInfo 
Professional 11.5.2 did not support the ANZLIC and INSPIRE metadata profiles. Refer to the MapInfo Manager 1.3.2 
Release Notes for more information.

Role of Configuration File for Library Service Records

In MapInfo Manager 1.3.2, records managed by the Library Service will now identify the type of record. If you click on 
the View/Edit Metadata menu item on the Table List or Layer Lontrol to view the metadata viewer, the configuration file 
does not play any role in identifying the MapInfo Manager 1.3.2 records. MapInfo Professional 11.5.3 will identify the 
Schema Editor Control Document (SECD) needed to display the record.

Role of Configuration File for Catalog Browser Records

In MapInfo Professional 11.5.3, there will be support for displaying the records of a non-MapInfo Manager Catalog 
Service for the Web (CSW) with the help of the SECD mentioned in the configuration file.

In MapInfo Professional 11.5.2, Catalog Browser records were always displayed using the ISO SECD.

Known Issue

There is an issue when editing a metadata record harvested by MapInfo Manager 1.2.

When editing a record, in the Identification Information tab, setting the Resolution Distance field blank under the 
section Spatial Resolution causes the value in the Unit of measurement field to be set to blank as well.

As a workaround, you will need to enter a value in the Resolution Distance field if you want the Unit of 
measurement field to be populated with a value.

Progress and Resolution of Outstanding Issues

Issue Number Description and Resolution

MIPRO-31436 SQLite: Server_Execute returns an error code when executing a Select * statement from MAPINFO_
MAPCATALOG where TABLENAME = <a non-existent table> 

Resolution: Fixed. In MapInfo Professional 11.5.2, when executing a MapBasic Select statement in the Server_
Execute( ) function, an error message would appear when the Select statement specified a table that did not exist 
in the database. 

For example, Server_Execute(1, "Select * from MAPINFO_MAPCATALOG where TABLENAME = 'TABLE_
NAME'") returned the following error message:

Invalid server operation.

MIPRO-31442 The Server Create Table statement in MapBasic creates a SQLite table that is read-only when there is no 
MAPCATALOG table in the database.

Resolution: Fixed. This statement no longer requires a MAPCATALOG table to create a table which you can 
write into.

MIPRO-31549 In MapInfo Manager 1.3, extra namespaces appear in the metadata record when the record is saved using the 
UpdateRecord API on the Library Service webpage.

Resolution: Fixed.
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Maintenance Release 11.5.2
This section lists the updates made since the 11.5.1 release. The 11.5.2 Maintenance Release is cumulative and 
includes all updates supplied with the 11.5.1 Maintenance Release.

• Display and Work with Your SQLite (*.sqlite) Data
• New Web Feature Service (WFS) 1.1 Support
• Correcting how Web Map Service (WMS) Images Display on the Map
• Now Use Single Sign-On Credentials for Proxy Servers Accessing Map Services
• Performance Enhancement for the Browser Window
• Enhancements for the Legend Designer Window
• MapInfo Professional does not Maintain the Curve Type in Oracle Data
• New Logging for Licensing
• Now Save More Details in the minidump File
• New Font Sets in MapInfo Professional
• Dialog Box Enhancements
• New Fill Patterns
• New File Versions and TAB, MIF/MID, and WOR Support
• MapInfo Manager 1.3 support with MapInfo Professional 11.5.2
• Known Issues
• Progress and Resolution of Outstanding Issues

Display and Work with Your SQLite (*.sqlite) Data
MapInfo Professional supports SQLite databases through OSGeo FDO Data Access Technology, so that you can work 
with spatial data stored in SQLite database files. This means that:

• you can display your existing SQLite data on a map in MapInfo Professional;
• you can save your MapInfo tables to your existing SQLite database to take advantage of the capabilities provided 

by a transactional SQL database engine (you cannot create a new SQLite database from MapInfo Professional); 
• you can share spatial data with other applications, such as Autodesk products: AutoCAD, Map 3D, Civil 3D, and 

Autodesk Infrastructure Modeler.

A separate document, titled MapInfo Professional 11.5.2 New Feature Documentation, describes how to open and 
work with SQLite database tables. It also describes how to share your custom symbols with other applications and how 
to share data with Autodesk products. For more information about SQLite, see the http://www.sqlite.org website.

MIPRO-31805 Issue with spatial filtering in MapInfo Professional 11.5.2 WFS 1.1.When trying to select a feature within the 
current mapper, the following error message is generated:

Operation canceled. An error occurred while processing the GML returned from the WFS Server.

Resolution: Fixed. The issue was related to internationalization. 

MIPRO-31827 Tile server layers do not allow styles to be set as grayscale. You cannot use the style override for a tile server 
layer to set an image to grayscale or in color. In MapInfo Professional 11.5.x, both the Original Image and the 
Grayscale radio buttons are disabled in the Adjust Image Styles dialog box.

Resolution: Fixed. Both the radio buttons are enabled now in the Adjust Image Styles dialog box so you can 
override a style.

MIPRO-32542 WMS layers do not allow styles to be set as grayscale. Similar to a tile server layer, both the Original Image and 
the Grayscale radio buttons are disabled in the Adjust Image Styles dialog box.

Resolution: Fixed.

Issue Number Description and Resolution
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FDO (Feature Data Object) is an interface for storing, retrieving, updating, and analyzing spatial data. MapInfo 
Professional installs an FDO Provider for SQLite (spatial), so that you can work with SQLite database files. For more 
information about FDO, see http://fdo.osgeo.org.

Some Operations Require a Map Catalog

MapInfo Professional opens SQLite database tables as mappable without requiring a MapInfo Map Catalog. With other 
types of databases, such as Oracle or SQL Server, MapInfo Professional stores information about spatial tables and 
views in the database in a special table called a Map Catalog (a MAPINFO_MAPCATALOG file). MapInfo Professional 
does not need to do this with a SQLite database.

However, the following operations in MapInfo Professional require the presence of a Map Catalog and generate an 
error when working with tables in a SQLite database that does not have a Map Catalog:

• Picking a table in the Make Table Mappable dialog box, which only lists tables that do not have a geometry column 
in the SQLite table.

• Picking a table in the Change DBMS Style dialog box. 
• Using the SERVER CREATE MAP and the SERVER CREATE STYLE MapBasic statements (these fail with an 

error message and error code 1730).

These operations generate the following error message when the SQLite database does not have a Map Catalog:

The MAPCATALOG on the specified connection is Read Only.

MapBasic Server Create Table Statement Creates a Read-Only Table when there is no Map Catalog

The MapBasic Server Create Table statement creates a SQLite table that is read-only when the database does not 
contain a MAPCATALOG table. You cannot insert data (write) to a read-only table.

To make the table editable you can update a metadata table, called geometry_columns, in the SQLite database. After 
creating the table using the MapBasic Server Create Table statement:

1. Open a connection to the SQLite database using a third-part management utility, such as SQLite Manager.

2. Update the geometry_columns table by modifying the coord_dimension column for the read-only table (that you 
created using the Server Create Table statement). The following is an example SQL statement:
UPDATE geometry_columns SET coord_dimensions = 2 WHERE f_table_name = 'tablename'

The geometry_column is not available for update from the MapInfo Professional Server_Execute command.

This issue is scheduled for resolution in version 11.5.3.

Handling Conversion of UTF-16 SQLite Source Data to ANSI MapInfo Professional Table Data

The FDO (Feature Data Object) SQLite source data is converted from Unicode (WideChar) to the current default ANSI 
code page. Depending upon the conversion, it is possible that a table column may have data which cannot be 
represented in the target code page. If so, any non-convertible characters will be represented by the character '_' in 
MapInfo Professional.

When a non-convertible data found in the table column, the column is flagged as Read Only. 

To prevent data loss, no change to data in the flagged column will be written back to the data store. Since the entire 
column is flagged as Read Only, all updates to data in this column will be disabled including data which was not 
converted.

If you execute an UPDATE or INSERT statement which includes this flagged column, it will return errors and the 
changes will be rolled back.

In MapInfo Professional, this behavior will be enabled by default. To override this default and enable update of the data 
store table, you must add IgnoreUnconvertedCharUpdates=FALSE to the FDO SQLite connection string, using a 
semicolon (;) as a separator.

For example:
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"\DATALINK\ConnectionString" = 
"File=C:\ProgramFiles\MapInfo\Data\SQLite\databasename.sqlite;PROVIDER=OSGeo.SQLite;Us
eFdoMetadata=TRUE;IgnoreUnconvertedCharUpdates=FALSE"

Display of SQLite Column Types in MapInfo Professional

When loading Date, Time, and DateTime column types from SQLite, they will be displayed as DateTime fields in 
MapInfo Professional:

• The Date column in SQLite will be displayed with the correct date and with a default Time value within MapInfo 
Professional (for example, “05/12/2012 12:00:00.000 AM”).

• The Time column in SQLite will be displayed with the correct time and a default Date value within MapInfo 
Professional (for example, “-1/-1/-001 12:40:45.166 PM”).

• The DateTime column display the correct date and time (for example, example: “05/12/2012 12:42:54.770 PM”).

When saving DateTime fields in MapInfo Professional back to SQLite, values that contain the portion of the invalid date 
("-1/-1/-001") will only save the time into the SQLite table. The rest of the values will be saved as DateTime object with 
values of both date and time stored in the table.

New Web Feature Service (WFS) 1.1 Support
MapInfo Professional 11.5.4 supports servers that work with version 1.1 of the Open Geospatial Consortium (OGC) 
Web Feature Service Interface Standard. A Web Feature Service (WFS) provides an interface allowing requests for 
geographical features across the internet using platform-independent calls. 

A separate document, titled MapInfo Professional 11.5.2 New Feature Documentation, includes the following topics 
that describe situations and conditions to be aware of when working with a WFS 1.1 server.

• Applying a Coordinate Order Override to Correct how Objects Display on the Map
• Testing the Coordinate Order of a WFS Table
• Spatial Row Filters
• No Support for WFS-T with WFS 1.1
• How to determine which version of WFS you are using?
• Working with WFS Tables that have Nested Structures
• Setting the Number of Records (Features) that a WFS Server Returns

For more information about the Open Geospatial Consortium (OGC) and Web Feature Service Interface Standard, see 
http://www.opengeospatial.org.

Improved WFS Schema Processing

MapInfo Professional 11.5.2 has improved schema processing. When older versions of MapInfo Professional were 
unable to process an item returned by the WFS server during the DescribeFeatureType request they would display an 
error and stop processing the schema (XML table definition). MapInfo Professional 11.5.2 understands and processes 
more than past releases, and it creates a table structure using the columns it could process from the schema.

MapInfo Professional downloads the table chosen in the Open WFS Table dialog box using that portion of the table 
structure it can decipher. In rare cases, there may be items in the server table that MapInfo Professional is unable to 
download.
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Correcting how Web Map Service (WMS) Images Display on the Map
MapInfo Professional 11.5.2 supports servers that work with the Open Geospatial Consortium (OGC) Web Map 
Service Interface Standard. A Web Map Service (WMS) provides an interface allowing requests for geo-registered map 
images across the internet using platform-independent calls to geospatial databases.

MapInfo Professional sends map bounds (coordinate information) when requesting a map image from a WMS server. 
If the server interprets the map bounds in the incorrect order, then the WMS map image will not display or is in the 
wrong location and distorted. If this occurs, then you will need to override coordinate order in use by the server. A 
separate document, titled MapInfo Professional 11.5.2 New Feature Documentation, includes the following topics that 
describe how to apply a coordinate override.

• Applying a Coordinate Order Override to a WMS Table or Server
• Testing the Coordinate Order of a WMS Table 

This issue, displaying map images with incorrect coordinate order, only affects map images that are retrieved from 
some WMS 1.3.0 servers.

For more information about the Open Geospatial Consortium (OGC) and Web Map Service Interface Standard, see 
http://www.opengeospatial.org.

Now Use Single Sign-On Credentials for Proxy Servers Accessing Map Services
MapInfo Professional 11.5.2 supports single sign-on authentication with proxy servers while accessing tile map 
services, such as Bing Map. MapInfo Professional signs on to the proxy server for you by automatically passing your 
Windows Authentication credentials (your Windows username and password), so that you do not have to type your 
proxy username and password.

Support for single sign-on authentication for proxy servers is in addition to our existing support for basic authentication 
for proxy servers. If you have your proxy server set up with basic authentication, then you still need to enter a 
username and password. For automatic authentication, you must have NTLM, Kerberos, or Negotiate authentication 
set up on the proxy server, and your proxy access credentials must be the same as your Windows Authentication 
credentials.

Setting automatic authentication with a proxy server affects Bing Map, OSM Roads, Move Map, and the Web Feature 
Service (WFS).

This single sign on experience does not apply to Tile Server authentication when the Tile Server you are using requires 
you to sign on before accessing map tiles.

Microsoft ISA and TMG Proxy servers use Negotiate authentication when authentication mode is set to 
Integrated.

Performance Enhancement for the Browser Window
The Browser window is now more responsive (such as with window resizing and cell editing).

Enhancements for the Legend Designer Window
MapInfo Professional 11.5.2 adds improvements to the Legend Designer window.

Legend Designer Window now Displays Images more Clearly

The Legend Designer Window in MapInfo Professional 11.5 displays symbols as raster instead of vector, which 
sometimes results in blurry images. In MapInfo Professional 11.5.2, the Legend Designer window changes the 
rendering for point styles that are based on True Type Fonts, so that they are drawn as vector. Custom symbols, line 
styles, and region styles must still be drawn as raster, but they now render without anti-aliasing and are not blurry. If 
you wish to see smoothed custom symbols, line styles, and region styles, you can turn anti-aliasing on using the new 
MapBasic command, Set Designer Legend Antialias On.
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There may be slight differences in the white space surrounding legend swatches when compared to previous versions, 
because of the rendering changes made for point styles.

Legend Designer Window has Keyboard Shortcuts

MapInfo Professional 11.5.2 includes shortcuts for the Legend Designer window. 

Pressing the Tab key selects and gives the keyboard focus to the first (left-most) button on the Legend Designer 
toolbar.  When a toolbar button or control already has the focus, pressing Tab moves the keyboard focus across the 
buttons or controls that are enabled in a left to right direction. Use Shift + Tab to reverse the direction. When a Legend 
Designer toolbar control has the keyboard focus, then pressing the Enter or Space key re-executes the command. 
When the right-most toolbar control has the keyboard focus, pressing Tab moves the keyboard focus into the canvas 
area of the Legend Designer window and the canvas has a dotted line drawn around its border. You can use the arrow 
keys to scroll in the Legend Designer window or move selected frames in the window.

When the Legend Designer Window is Active

When Selecting One or More Frames in a Legend Designer Window

To select multiple legend frames in a Legend Designer window, click and drag the mouse over the legend frames. 

To add more legend frames to your selection, press Ctrl (or press Shift) while you click and drag the mouse over the 
legend frames to add to the previous selection.

When Repositioning Legend Frames in the Legend Designer Window

Action Keystroke

Closing the active window Ctrl+F4

Switch between open windows Ctrl-Tab

Ctrl-F6

Switch between open windows in reverse order Ctrl+Shift+Tab

Ctrl+Shift+F6

Action Keystroke

Move selected legend frames one pixel to the left Left arrow

Ctrl+Left arrow

Move selected legend frames one pixel to the right Right arrow

Ctrl+Right arrow

Move selected legend frames up one pixel Up arrow 

Ctrl+Up arrow
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Pressing Shift plus an arrow key moves selected legend frames by increments that are based on the grid size, even 
when the grid is not visible. 

MapInfo Professional does not Maintain the Curve Type in Oracle Data
When reading Oracle tables, MapInfo Professional changes records containing geometries that do not directly 
translate to MapInfo Professional geometry types. This happens when working with lines and polygon boundaries 
containing segments that are curve types or circles. MapInfo Professional does not support the curve type, so it 
converts these to polylines. MapInfo Professional also converts circles into regions. When saving these records back 
to the database, you may lose some topological information as a result. This is something to be aware of when sharing 
your Oracle data with other applications, such as Autodesk's Map3D.

MapInfo Professional shows a message before saving data back to the Oracle database when that data contains 
curved geometries. The message is as follows:

The Oracle table you are updating contains one or more geometry types that MapInfo Professional does not 
support, so the geometry type has been converted to a supported type. Saving these geometries may introduce 
topological errors into your database. Click Yes to continue, or No to discard changes that were made to 
unsupported geometries. Edits to attribute data save in either case.

When executing the MapBasic Commit statement, the prompt displays only when it contains the Interactive 
keyword.

Move selected legend frames down one pixel Down arrow 

Ctrl+Down arrow

Move selected legend frames one increment to the left on the grid Shift+Left arrow 

Shift+Ctrl+Left arrow

Move selected legend frames one increment to the right on the grid Shift+Right arrow 

Shift+Ctrl+Right arrow

Move selected legend frames up one increment on the grid Shift+Up arrow  

Shift+Ctrl+Up arrow

Move selected legend frames down one increment on the grid Shift+Down arrow  

Shift+Ctrl+Down arrow

Action Keystroke
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New Logging for Licensing
You can now address licensing issues, such as the loss of licenses, by specifying that error messages from the 
License Server are written to a log file. You would use this capability when reporting licensing issues to your Customer 
Support Representative, who will assist you with setting the license logging level. Your Customer Support 
Representative will read the messages in this log file to assist with troubleshooting license issues.

To turn on error logging and specify the amount of information saved to a log file, you would set a License Server 
environment variable called MI_LOGLEVEL to a value of 1 to 3. Setting a value of zero (0) disables error logging. By 
default, the License Server logging level is set to one (1), which logs error messages for some specific situations and if 
there is a deletion of invalid licenses.

The License Server records every license activity that is happening on the server to a file called PBLicense.log in the 
Windows %temp% folder on the machine where the License Server is running. Client software, such as MapInfo 
Professional, records every license activity that is happening on the client machine to a file called PBLicense.log in 
the Windows %temp% folder on the client machine. The %temp% folder is set by default to:

Windows XP: C:\Documents and Settings\<username>\Local Settings\Temp 

Windows 7, 2008: C:\Users\<username>\AppData\Local\Temp

When reporting a licensing issue to your Pitney Bowes Software Technical Support representative, you will send this 
log file along with the details of your issue.

If the log file reaches the maximum size limit (of approximately 1MB), then it is renamed to PBLicenseLog.bak, and 
the new log entries are written in the new PBLicense.log file.

To set the logging level:

1. Select Start > Run. In the Run dialog box, type Control Panel and then:
On Windows XP: Select System. 
On Windows 7, 2008: Select System and then Advanced System Settings.

2. In the System Properties dialog, select the Advanced tab and click Environment Variables.

3. In the Environment Variable dialog box, in the User variables panel, click New.

4. In the New User Variable dialog box:
• In the Variable name field, type MI_LOGLEVEL.
• In the Variable value field, type the logging level (a value of 0 to 3). Setting a value of zero (0) disables error 

logging. Setting no value causes the License Server to use a default logging value of one (1).

5. Click OK to close the dialog boxes and save the new variable.

If the License Server is running, then stop it and restart it to apply the new system variable and start logging messages. 
If MapInfo Professional is running, then you must also restart it.

Logging 
Level Action

0 Disables logging.

1 Logs short error messages and error codes, and logs if there is a deletion of invalid licenses. This is 
the default setting. 

2 Logs detailed error messages and error codes, logs if there is a deletion of invalid licenses, and logs 
additional diagnostic messages.

3 Logs everything that level 2 logs with additional information. This level is only useful for client 
applications like MapInfo Professional that use borrowable or distributable licenses.
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Now Save More Details in the minidump File
When MapInfo Professional closes unexpectedly, it generates a binary log file that is referred to as a minidump file. 
Your Technical Support associate uses this file to investigate and fix the issue that caused the unexpected closure. 
Depending on what occurred, you may not need to provide sample data or access to your data. You can now set an 
environment variable to generate a minidump file that has more information in it. This helps your Customer Support 
representative determine why MapInfo Professional closes unexpectedly and how to fix the issue.

To include more details in the minidump file by setting the MI_FULLDUMP environment variable:

1. Select Start > Run.

2. In the Run dialog box, type Control Panel.

3. In the Control Panel, do one of the following:
On Windows XP: Select System. 
On Windows 7, 2008: Select System and then Advanced System Settings.

4. In the System Properties dialog box, select the Advanced tab and then click Environment Variables.
The Environment Variable dialog box opens.

5. In the User variables panel, click New.

6. In the New User Variable dialog box, do the following:
• In the Variable name field, type MI_FULLDUMP.
• In the Variable value field, type the value 1.

7. Click OK to close the dialog boxes and save the new variable.

If MapInfo Professional is running, then stop and restart it now to apply the new system variable. 

MapInfo Professional saves the minidump file in the Windows %temp% folder under a subfolder called MIPRO. The 
%temp% folder is set by default to:

Windows XP: C:\Documents and Settings\<username>\Local Settings\Temp 
Windows 7, 2008: C:\Users\<username>\AppData\Local\Temp

To browse directly to this folder location:

1. From the Start menu select Run. 
The Run dialog box opens.

2. In the Open text box, type %temp%/MIPRO.

The minidump file has a date and time stamp in its name in the format yyyy_mm_dd_hh_mn_ss.dmp. Where:

• yyyy – year
• mm – month
• dd – day
• hh – hour
• mn – minute
• ss: seconds

When reporting an issue to a Technical Support associate, send this file with your report. Depending on what the issue 
is, this file will speed up the response time to your issue. The minidump file could be large; a typical size would be 
between 500 MB and 1 GB. You may need to compress the file (using a compression tool, such as WinZIP) before 
sending it to your Technical Support associate, or you may need to make it available for download.

New Font Sets in MapInfo Professional
There is a new utility which will install five new sets of fonts in MapInfo Professional. This utility will accompany this 
patch. You would only install this utility if you want to use the additional five fonts. The new font sets are:

1. MapInfo ER Incident Center Regular (TTMIER.ttf)
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2. MapInfo ER Hazmat Regular (TTMIERH.ttf)

3. MapInfo Gas Regular (TTMIGAS.ttf)

4. MapInfo Points of Interest Regular (TTMIPOI.ttf)

5. MapInfo Water Regular (TTMIWA.ttf)

These fonts are automatically installed in the full MapInfo Professional 11.5.2 installer.

These five files will get copied in the Windows Fonts folder on your computer. Depending on the Operating System, the 
location could be either C:\Windows\Fonts or C:\WINNT\Fonts.

Installing this Utility

Follow the steps below to install this utility:

1. Create a temporary folder on your computer, for example, C:\Temp\MIFonts.

2. Navigate to the location http://www.pbinsight.com/support/product-downloads/item/mapinfo-professional-
additional-fonts.

3. Click the link MapInfoSupplementalFonts11.5.2.zip in the section Download Links.

4. Click Save to save this file in the folder created in Step 1.

5. Double click the file MapInfoSupplementalFonts11.5.2.zip to unzip the utility.

6. Double click the file MapInfoSupplementalFonts11.5.2.exe to start the installer wizard.

7. Follow the instructions to complete the installation.

Advanced Installation for System Administrators

This section is for the system administrator installing this utility in silent mode using a command line.

Open the command prompt as an administrator and run the following command:

<path to utility exe>\MapInfoSupplementalFonts11.5.2.exe /s /v"/q"

Known Issue

You can only view the new fonts on a map if you have the utility installed on your computer. If you open the same map 
after uninstalling the utility, you will see squares representing points instead of the originally chosen font symbol. 

If you open a map with the new font sets on another computer with MapInfo Professional 11.5 installed, but without the 
MapInfo Supplemental Fonts utility, you will see suqares instead of the new font symbols.

For example, in the map below, the five new fonts are used to denote points on the map.
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After you uninstall MapInfo Supplemental Fonts and open the same map again, you will see squares in places of the 
font symbols used.

In the Symbol Style dialog box, you will not see the new fonts because they were removed from the system.  You can 
either reinstall the MapInfo Supplemental Fonts utility or select a different font.

Dialog Box Enhancements
Some dialog boxes that display a list of tables have been enhanced. The size of the dialog box can increase, making it 
easier to see the list of tables. Upon reaching the maximum size, scrollbars will appear. The following dialog boxes 
have been enhanced:

• Close Table
• Save Table
• Save Copy As
• Revert Table
• Save Query
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• New Report
• Table Export
• Delete Table
• Rename Table
• WMS Table
• WFS Table
• Add to Library Service

New Fill Patterns
MapInfo Professional 11.5.2 now includes seven new fill patterns in the Region Style dialog box. The new patterns are 
added in the range 187 (H23)–193 (F24) in the Fill Pattern table.

New File Versions and TAB, MIF/MID, and WOR Support
In the MapInfo Professional Help System, the section titled File versions and TAB, MIF/MID, and WOR Support  
requires the following update for this 11.5.2 release.
:

MapInfo Manager 1.3 support with MapInfo Professional 11.5.2
MapInfo Professional 11.5.2 will now support editing in MapInfo Manager 1.3. 

MapInfo Manager 1.3 now includes the Repository Service as a secured service. In MapInfo Manager 1.2.x, all 
services like MapInfoManager, Catalog Service for the Web (CSW), Web Mapping Service (WMS), and 
RepositoryService were included unsecured. The secure Repository service means that you only have Read access to 
the library.

To enable Write access to the library, type the following URL in your web browser:

http://yourServer:8080/RepositoryService/
PBBIRepositoryManagement?action=setPermissions&admin=admin&username=everyone&permissio
ns=all&resourcePath=/

Version 
Number TAB

MIF-
MID WOR Action

1152 X Saving SQLite tables

X Saving tables containing Autodesk Text Objects

X Browser window that is sorted with a five column sort condition
MapInfo Professional 11.5.4 Release Notes 15



To enable back Read access to the library, type the following URL in your web browser:

http://yourServer:8080/RepositoryService/
PBBIRepositoryManagement?action=setPermissions&admin=admin&username=everyone&permissio
ns=read&resourcePath=/

Follow the instructions in the ACL Management REST Interface to set user permissions.

Known Issues

There are some isues in the integration of MapInfo Manager 1.3 and MapInfo Professional 11.5.2. They are:

• MapInfo Manager 1.3 now includes two new metadata profiles ANZLIC and INSPIRE. There is no support for these 
profiles in MapInfo Professional 11.5.2.

• MapInfo Manager 1.3 now displays whether a particular metadata record is valid or not. If such a valid record is 
edited with MapInfo Professional 11.5.2, the status of the record changes to “Invalid”.

• A record which has been edited in Catalog Browser in MapInfo Professional 11.5.2 cannot be edited in MapInfo 
Manager 1.3 in the Resource Constraints section when you click the Apply Template button. You must edit the 
values manually in this section. In addition, when you re-apply a template to record containing values in the Spatial 
Resolution section, the server becomes unresponsive.

• In MapInfo Professional 11.5.2, you will be unable to upload an image to the repository from the Graphic Overview 
section. MapInfo Manager 1.3 adds the image into the repository. If a record has an image already added from the 
MapInfo Manager editor, and you remove the associated Graphic Overview field from record, MapInfo 
Professional 11.5.2 does not remove the corresponding image from the repository.

Known Issues

Additional Time Required to Open WMF Files with Gray Scale Support

It may take more time to open a Windows Metafile Format (WMF) file in MapInfo Professional 11.5.2 compared to 
previous versions due to an issue with WMF files with extended gray scale support.

Unable to Open Specific TIF File in MapInfo Professional 11.5.2

You may be unable to open a TIF file with extended gray scale support in MapInfo Professional 11.5.2.

Progress and Resolution of Outstanding Issues

Issue Number Description and Resolution

MIPRO-8350 Drawing a polyline using a custom tool lacks the same precision as using the polyline from the Drawing Toolbar..

Resolution: Fixed. When using the custom polyline or polygon tool in conjunction with CommandInfo( ) to get 
the object geometry, the coordinates for the nodes will now be returned in the current MapBasic Coordinate 
System.

MIPRO-13794 A jpeg image file saved in Adobe Illustrator or any imaging software displays better in MapInfo Professional 8.5 
than MapInfo Professional 10.5.

Resolution: Fixed.
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MIPRO-15743 For the string concatenation operator (&) to be interpreted correctly, there must be a space between the operator 
and the preceding identifier. In prior versions of MapInfo Professional, this space was omitted when writing 
expressions containing this operator.

Resolution: Fixed. Workspaces now will be written correctly. However, MapInfo Professional will still not be able 
to read the expression in any existing workspaces with this problem. As a workaround, such workspaces can be 
manually edited. You need to add a space before and after the ampersand (&) in the expression or replace the 
ampersand with a plus sign (+) since the addition operator is the same as the concatenation operator when 
acting on strings

MIPRO-17184 In MapInfo Professional 11.0, you will be unable to save a raster file as a TIFF G4 format with a custom page size 
of 1050 mm X 550 mm, a map scale of 1:500, and a resolution of 300 dpi. You will encounter a memory error 
because the output file will reach the limit of 10,000 pixels in height or width.

When the resolution is reduced to 200 dpi, the following error message appears:

raster Engine error: 4

You will not see the error message when you use a resolution of 200 dpi in MapInfo Professional 10.5.

Resolution: Fixed. Use MapInfo Professional 11.0 on a 64 bit machine with 4 GB of RAM.

MIPRO-20558 Some numeric derived columns are created as type LargeInt. MS Access does not support this type, so an error 
was occurring in the process a creating such a table.

Resolution: Fixed. LargeInt now will be serialized as a 20-character string for MS Access. If you open such a 
table in MS Access it will appear as a character string type. However, since the .TAB file that was created says it 
is a LargeInt type, MapInfo Professional will interpret it as a LargeInt

MIPRO-20666 There is no autoscroll upward when moving a layer up in Layer Control. Autoscroll downward is possible when 
you move the layer down.

Resolution: Fixed.

MIPRO-22232 The CurTime( ) and CurDateTime( ) functions return milliseconds as 000 in the output, when executed in 
MapBasic.

The data types Time and DateTime can store time in milliseconds. However, the CurTime( ) and CurDateTime( 
) returned the current time with the millisecond value truncated and were only accurate to the second.

Resolution: Fixed.

MIPRO-22741 On Windows 7, the size of the nodes in region tables appear small. This includes the nodes that display when 
you turn on the layer properties for Show Nodes and Show Centroids, as well as for nodes used during object 
editing.

Resolution: Fixed. The nodes now display in Windows 7 at a size that is consistent with the node size on other 
operating systems.

MIPRO-25013 Cannot open an MWS file if the path has a period ( . ) in it. The following error message displays:

File is not a valid table, workspace, or application.

Resolution: Fixed.

MIPRO-25043 The TAB key does not work in Named Views.

Resolution: Fixed.

MIPRO-25129 The Sort dialog box and the MapBasic Set Browse Order By statement did not support 5–column sorting.

Resolution: Fixed. 

Issue Number Description and Resolution
MapInfo Professional 11.5.4 Release Notes 17



MIPRO-25546 The Workspace Packager tool changes the character set of a table when the table is copied from one location to 
another.

Resolution: Fixed. The Workspace Packager now writes the machine’s default character set in the tab file, 
instead of the neutral character set.

MIPRO-26351 There are timeout issues working with Web Feature Service (WFS) HTTPS.

Resolution: Fixed. The communication code with WFS has been updated.

MIPRO-27265 In the Legend Designer Window, images (such as symbols) display as raster instead of vector. This causes 
raster elements on the legend canvas to appear blurry.

Resolution: Fixed. Symbols are now drawn as vector. Line and region styles are still drawn as raster, but are no 
longer anti-aliased, so they do not appear blurry. Changes were made to how symbol styles are drawn, so there 
may be slight differences in the white space surrounding legend swatches when compared to previous versions. 
For details, see Legend Designer Window now Displays Images more Clearly on page 8.

MIPRO-27298 Universal Translator closes unexpectedly when translating a TAB file into a SHAPE file.

This particular dataset requires the FME engine to load DLLs that were not previously included with the MapInfo 
Professional’s FME OEM package.

Resolution: Fixed. The missing DLLs have been procured from Safe Software and are now part of MapInfo 
Professional’s FME OEM package.

MIPRO-27927 The NamedViews tool searches for the file called nviews_dockinfo in the incorrect folder.

The NamedViews tool uses the MapBasic compiler version number to identify and create the path to look for this 
file. This creates a problem with a MapBasic patch, because the version number of the compiler changes and the 
tool searches for the file in the wrong folder.

Resolution: Fixed.

MIPRO-28166 When exporting some .tab files through GELink, the following error message displays:

Warning! An error occurred in the GoogleEarth Link Module PromptUser. The error was: 802:(gelink.mb:336) 
Subscript out of range.

Resolution: Fixed.

MIPRO-28866 Moving individual nodes in a particular region in MapBasic was causing MapInfo to close unexpectedly. The 
region had a polygon within a polygon within a polygon. 

Resolution: Fixed.

MIPRO-28977 When working with polyline data, selecting Object > Disaggregate and checking the Retain Holes in Regions 
check box results in the error, “Operation Canceled”.

Resolution: Fixed.

MIPRO-29530 After pinning and saving the Named Views tool in MapInfo Professional, it remains minimized when MapInfo 
Professional is run again.

Resolution: Fixed.

MIPRO-30174 The Enter key and the N key do not function in the Named Views tool when opening a table.

Resolution: Fixed.

Issue Number Description and Resolution
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Maintenance Release 11.5.1
This section lists the updates made since the 11.5 release:

• Improved Workspace Error Handling
• Changes in Legend Designer Window
• Oracle Connect
• Oracle Operating System Authentication and Configuration
• One-Click Sorting in the Browser Window
• Behavior Change in the Quick Start Dialog Box
• New File Versions and TAB, MIF/MID, and WOR Support
• Change to /Z Parameter in EasyLoader
• Progress and Resolution of Outstanding Issues

Improved Workspace Error Handling
In previous versions of MapInfo Professional, any error that occurred when opening a workspace halted the processing 
of that workspace. 

In MapInfo Professional 11.5.1, you can now continue loading a workspace, even if some of the tables could not be 
opened. 

Missing or otherwise unavailable tables are one of the most common problems you may encounter when opening a 
workspace. In a workspace, all of the tables are opened first, so if any tables cannot be opened, the workspace is 
essentially useless. 

Since missing or otherwise unavailable tables are a common problem, the goal is to continue processing a workspace 
even after you fail to open a table. This could be due to a missing table, a table which is RDB, and so on. In addition, if 
any tables fail to open, errors must be ignored and suppressed, which may arise later in the workspace due to those 
tables being missing; for example, references to the missing tables in windows and queries and references to any 
columns in the missing tables. If a table fails to open, there may be references to it as a table or a layer, but there is no 
way of knowing what type of table or layer it was. 

You can now find the missing table from the Please locate dialog box in case if it was moved or renamed. This dialog 
box has been modified to provide more options. Previously, if you were unable to locate a table, the only option was to 
cancel. This would have halted the processing of the workspace. You can still stop the processing of a workspace by 
clicking the Abort button. However, since MapInfo Professional is now allowing the processing of the workspace to 
continue, you can skip the table rather than abort. You can click the Skip button to skip the problem table, but you can 
also click the Skip All button to skip any subsequent missing tables in the workspace.

MIPRO-30182 In the Named Views tool, if you select a zoom range on a map or table from the tree view, hitting the Enter key 
does not perform the same operation as clicking the Goto button.

Resolution: Fixed.

MIPRO-31173 Browsing a SQLite MapCatalog table returns wrong results when no primary key and improper FDO metadata 
are used.

Resolution: Fixed. When creating a MapCatalog table, you should use a primary key in the Create Table 
statement. In addition, the column names should be in uppercase.

Issue Number Description and Resolution
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If you open a workspace with a number of RDB tables but do not know the password to the server, you will 
unfortunately need to cancel out of the Authentication dialog box for each table. 

Once the processing the workspace has been completed, windows that contain only missing tables will be shut down 
(for example, browsers and single-layer mappers).

You will see a summary of errors, if any, occurred. This dialog box displays regardless of the type of error, and whether 
or not errors were skipped or caused the workspace to stop processing.

The Workspace Error Log dialog box is only for the currently opened workspace.

Changes in Legend Designer Window

New Functionality for Map Legend Frames in the Legend Designer Window

In MapInfo Professional 11.5.1, we have added new support for legend frames in the Legend Designer Window. You 
now have the ability to set the visibility for individual label items (allowing items to be hidden). There is also a new 
option for sorting the labels within a legend frame in ascending/descending order, based on the label string. And there 
is now support to manually reorder labels within a legend frame. 
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Based on your selection of a legend theme, some or all of the following buttons display in the Legend Frame 
Properties dialog box for different theme frames (See Examples of Different Legends in the Legend Frame 
Properties Dialog Box for related images):

Description of Buttons

Button Name Description

Aa Font Picker You can change the font for all labels in the selected frame.

Sort Labels in 
Ascending 
Order

This button changes the sort order of the legend rows. 

For thematic legends, an ascending sort means the rows are displayed in a top to
bottom manner that makes sense for the particular theme type; for example, a Ranged
theme frame that displays the rows from lowest to the highest range. 

For a Pie or Bar theme, an ascending sort means the categories are listed in the order
selected by you.

For an Individual Value legend, the label sort order is based on the original order of the
items when the theme was initially created. This also means that changing a text label
for Individual Value themes will not affect the sort order. (When in ascending mode, the
button will look pressed.)

This button displays in a Graduated theme frame and a Ranged theme frame.

Sort Labels in 
Descending 
Order

This button changes the sort order of the legend rows. 

For thematic legends, a descending sort means the rows are displayed in a bottom to 
top manner that makes sense for the particular theme type. 

For an Individual Value legend, the label sort order is based on the order of the items 
when the theme was initially created; for example, an Individual Value legend theme 
would display rows alphabetized from Z to A range. However, changing a text label for 
Individual Value themes will not affect the original sort order. 

For Graduated Symbol legend, a descending sort means the values are listed from 
largest to smallest. (When in descending mode, the button will look depressed.)

This button displays in a Graduated theme frame and a Ranged theme frame.

Clear Sort This button allows you to undo an ascending, descending, or custom sort for a map 
legend. It applies only to map legends and will be hidden for thematic legends. Map 
legends are created with a default order based on the properties used to create it. You 
have no control over this initial ordering, but clicking this button will restore it.

This button displays in a Map legend frame.

Move Selection 
Up

You can use this button to manually reorder the labels, and create a custom order. It 
only displays in Individual Value theme legends and map legends. If the first row is 
selected, this button is disabled.

Move Selection 
Down

You can use this button to manually reorder the labels, and create a custom order. It 
only displays in Individual Value theme legends and map legends. If the last row is 
selected, this button is disabled.

Show Record 
Count

This button toggles the display of record counts for each label of the Labels group box. 

It only displays in Ranged, Graduated, and Individual value themes. Map legends and 
other thematic types do not support record count so this button will be hidden. 

When the record counts are turned on, the record count displays next to each label text, 
and at the bottom, it shows the number of objects for the currently selected label.
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Functionalities

Title

You can change the text and/or font for Title in a Legend Designer frame. You can also delete the text if no title is 
desired.

Subtitle

You can change the text and/or font for Subtitle in a Legend Designer frame. You can also delete the text if no subtitle 
is desired.

Restore Default Title and Labels

This button is only available for thematic frames. It is not available/visible for map frames. It will reset the title, subtitle 
and labels to their default state. For certain theme types; Pies, Bars, Dot Density, Graduated Symbol, and Grid, it will 
also restore visibility of individual legend rows. For Ranges or Individual Value theme legends, any rows marked 
invisible will remain invisible.

Number of Columns

You can change the number of columns in the legend frame, either by editing the number shown in the edit box, or by 
using the up/down arrows to increase or decrease the number. The number of columns shown is automatically 
updated when you change row visibility; if the number of rows visible is less than the current number of columns, the 
number of columns truncates to the number of visible rows. However, once truncated, the number will not increase if 
you add more visible rows. Additionally, the up/down arrows will not increase the number of columns above the 
number of visible rows, or decrease it less than 1.

Labels

This group offers control of the labels within the legend frame. See the table, Description of Buttons for more details.

Edit Selected Text Here

You can use this text box to edit the text of the currently selected label(s). If multiple labels are selected, they are all 
changed. This control will show multi-line text if the legend label is multi-line. To insert a line break, click in the text box 
to position the cursor, and then press Enter. You can change the text for multiple items if you select them and type in 
the edit text box.

You can create multiline text labels for Map legends but not for Thematic legends.

Number of Objects

This is a read-only text field. It will show the number of objects for a label row if the record count is turned on (and the 
legend frame supports record count).

OK Button

Pressing the OK button exits the Legend Frame Properties dialog box and applies the changes to the legend frame.

Cancel Button

Pressing the Cancel button exits the dialog box without changing the legend frame. All modifications will be discarded.

Help Button

Pressing the Help button shows the associated help topic. However, for the MapInfo Professional 11.5.x maintenance 
release, there is no related help for this dialog. Instead, you will see a help topic error. All the help for this dialog is 
contained in this release notes document. Help will be available for this topic In MapInfo Professional 12.0 and higher. 
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Examples of Different Legends in the Legend Frame Properties Dialog Box

Map Legend Frame:

Graduated Symbol Theme Frame:
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Individual Value Theme Frame:

Ranged Theme Frame:
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Pie and Bar Theme Frame:

Dot Density Theme Frame:
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Refresh Legend Dialog Box

Refreshing Styles and Row Visibility

After you have edited styles in the Map window, you might need to refresh the legend, to bring it up to date. To refresh 
the legend, choose Legend Designer > Refresh. Depending on what edits you made to the map, refreshing the 
legend might have various effects:

• If you add new styles to the map, or if you modify existing styles, such as increasing the point size of a symbol, 
refreshing the legend will cause the new rows to appear in the legend, showing the new styles. 

• If you remove styles from the map, so that those styles are no longer used anywhere in that layer, refreshing the 
legend will remove those styles, that are no longer used, from the legend. 

• If you had previously hidden styles from the legend (by clearing them in the Legend Frame Properties dialog box), 
refreshing the legend will not cause those styles to reappear; those styles will remain hidden from the legend.

When a style override is created for a map layer that has a legend in a Legend Designer window, the legend 
automatically updates to show the style override. The text for the style override either comes from table metadata, or 
the first style row in the legend. If the override is turned off, the legend is recreated using the original schema and all 
rows are made visible.

Changes to Legend Designer Toolbar

New Modify Thematic Map Button

The Legend Designer window now includes a Modify Thematic Map button  on the window toolbar, which 
enables when you select a theme legend. Clicking the button displays the Modify Theme dialog box (as opposed to 
double-clicking the theme legend frame, which takes you to the Legend Frame Properties dialog box). 

Open Source Attribution Notice for the Extended WPF Toolkit 1.6.0

This product contains the Extended WPF Toolkit 1.6.0, which is licensed under Microsoft Public License. The license 
can be downloaded from http://wpftoolkit.codeplex.com/license. The source code for this software is available from 
http://wpftoolkit.codeplex.com.

Oracle Connect
You can now connect to Oracle using your Operating System (OS) authentication, for example, with Windows 
credentials, in both MapInfo Professional 11.5 and EasyLoader 11.5. There is a new Use Operating System 
Authentication check box on the MapInfo Oracle Connect dialog box.

After opening or saving an Oracle table while connected with OS authentication the user ID is written in the tab file. 
Only the server name gets written, so next time you open a table, MapInfo Professional automatically connects with 
OS authentication.

EasyLoader has the same new Use Operating System Authentication check box on the Oracle connection dialog 
box.

In addition, when running EasyLoader from the command line with Connection info as parameter, the parameter 
should contain only the server name (@ServerName), and not a user ID or password, when connecting with OS 
authentication. For the database authentication, provide the user ID, password, and server name. (UserName/
Password@ServerName).
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Oracle Operating System Authentication and Configuration
When you choose OS authentication for a user, the user account is maintained by the Oracle database, but password 
administration and user authentication is performed by the Operating System (OS). With OS authentication, your 
database relies on the underlying operating system to restrict access to database accounts. A database password is 
not used for this type of login.

By default, Oracle allows operating-system-authenticated logins only over secure connections, which precludes using 
Oracle .NET and a shared server configuration. This default restriction prevents a remote user from impersonating 
another operating system user over a network connection.

Setting REMOTE_OS_AUTHENT to TRUE in the database initialization parameter file forces the RDBMS to accept the 
client operating system user name received over a non-secure connection and use it for account access.

Any change to this parameter takes effect the next time you start the instance and mount the database. Generally, user 
authentication through the host operating system offers faster and more convenient connection to Oracle without 
specifying a separate database user name or password. Also, user entries correspond in the database and operating 
system audit trails.

Setting prefix for OS Authenticated User

Set the initialization parameter OS_AUTHENT_PREFIX, and use this prefix in the Oracle database user names. The 
OS_AUTHENT_PREFIX parameter defines a prefix that the Oracle database adds to the beginning of every user's 
operating system account name. When a user attempts to connect, Oracle compares the prefixed user name with the 
Oracle user names in the database.

For example, assume that OS_AUTHENT_PREFIX is set as follows:

OS_AUTHENT_PREFIX=OPS$

The initialization parameter OS_AUTHENT_PREFIX is case-sensitive in some operating systems. Refer to your 
operating system specific Oracle documentation for more information about this initialization parameter.

If a user named tsmith is to connect to an Oracle database installation and be authenticated by the Operating 
System, then Oracle Database checks whether a corresponding database user OPS$tsmith exists. If so, the user will 
connect. All references to a user authenticated by the Operating System must include the prefix, OPS$, as seen in 
OPS$tsmith.

The default value of this parameter is OPS$ for backward compatibility with previous versions of Oracle Database. 
However, you might prefer to set the prefix value to some other string or a null string (an empty set of double quotes: " 
"). Using a null string eliminates the addition of any prefix to operating system account names, so that Oracle user 
names exactly match operating system user names.

After you set OS_AUTHENT_PREFIX, it should remain the same for the life of a database. If you change the prefix, then 
any database user name that includes the old prefix cannot be used to establish a connection, unless you alter the 
user name to have it use password authentication.

Creating a User who is Authenticated by the OS

The following statement creates a user who is identified by Oracle and authenticated by the operating system or a 
network service. This example assumes that OS_AUTHENT_PREFIX = "".

CREATE USER scott IDENTIFIED EXTERNALLY;

Using CREATE USER <user name> IDENTIFIED EXTERNALLY, you create database accounts that must be 
authenticated by the operating system or network service. Oracle will then rely on this external login authentication 
when it provides that specific operating system user with access to the database resources of a specific user.

See the Oracle Database Advanced Security Administrator's Guide for more information about external 
authentication.
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One-Click Sorting in the Browser Window
You can now sort a table in the Browser window by clicking on a column header. Click the column header again to 
reverse the sort order. Clicking a column header produces a single-column sort; if you need to sort on multiple 
columns, use the Sort Multi-Column command on the Browser window menu.

Behavior Change in the Quick Start Dialog Box
The most recently opened workspace appears in the Quick Start dialog box under the Open Last Used Workspace 
option.

In prior versions of MapInfo Professional, selecting the menu option File > Close All or issuing the MapBasic 
statement Close All prior to exiting would clear the last used workspace name, so that the Open Last Used 
Workspace option was disabled. In 11.5.1, Close All no longer impacts the last used workspace option.

New File Versions and TAB, MIF/MID, and WOR Support
In the MapInfo Professional Help System, the section titled File versions and TAB, MIF/MID, and WOR Support  
requires the following updates for this 11.5.1 release.
:

Change to /Z Parameter in EasyLoader
The /Z parameter changed in EasyLoader to set Auto Select option instead of Always Geometry.

Version 
Number

TAB MIF-
MID

WOR Action

1150 X X MGI 1901 Datum #1021

X X CH1903 Datum #158

X X Schwarzeck (updated) datum for Namibia #159

X X North Sahara #1022

X Browser window with Filter conditions (Set Browse Filter statement)

X Browser window with hidden toolbar 
(Set Window FrontWindow( ) Toolbar Off  statement)

X Legend Designer legend windows 
(Create Designer Legend statement)

1151 X Legend Designer window with hidden toolbar 
(Set Window FrontWindow( ) Toolbar Off  statement)

X The Create Designer Legend statement with a sorted legend (Create 
Designer Legend statement with an Order clause inside a Frame clause), 
or a legend specifying visibility of individual rows (Create Designer 
Legend statement with a Display clause inside a Style clause)
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Progress and Resolution of Outstanding Issues

Issue Number Description and Resolution

MIPRO-18884 When using Query > Find, Try Substitutions from MAPINFOW.ABB were not persisted between sessions—no 
preference. 

Resolution: Now there is a support for writing the following check boxes in the MapInfo preferences file:

• Try substitutions from mapinfow.abb.
• Use the closest address number.
• Use a match found in a different boundary.

These check boxes can still be overridden by the MapBasic Programs and startup.wor.

Fixed.

MIPRO-19759 In EasyLoader, a connection string created in a tab file does not seem to work every time.

Resolution: Fixed.

MIPRO-21235 EasyLoader cannot upload geography from the command line in SQL Server 2008.

Resolution: Fixed.

MIPRO-23345 MapInfo Professional closes unexpectedly when trying to borrow a license that has been transferred from the 
License Server Utility 3.5.

Resolution: Fixed.

MIPRO-23920 If there is an invalid borrowable license on a MapInfo Professional or a Runtime machine and you enter 
distributed license credentials to activate, then every time MapInfo Professional starts, it will activate a new 
distributed license until all distributed licenses are consumed from the License Server Utility.

Resolution: Fixed.

MIPRO-24515 Uploading a table with a boolean field to PostGIS does not put the correct TYPE_NAME on the server side.

There is an inconsistency between EasyLoader and MapInfo Professional on how they save data on PostGIS.

EasyLoader uploads a logical field as smallint, whereas, MapInfo Professional uploads a logical field as boolean.

When you open a first table, uploaded by EasyLoader, in MapInfo Professional, the field shows up as smallint. 
When you open a second table, uploaded by MapInfo Professional, in MapInfo Professional, the field shows up 
as char[5].

Resolution: Fixed.

MIPRO-25230 You could be prompted to save unsaved legend objects in a Legend Designer window despite the fact the legend 
hasn't changed.

If a Legend Designer window is created from a map with multiple layers but only some are included in the legend, 
closing one of the tables that is in the map but not in the legend causes Mapinfo Professional to think the legend 
has changed.

Resolution: Fixed.

MIPRO-25454 The table name “Selection” sometimes fails to appear in the Table List window. 

Resolution: Fixed. 

MIPRO-26283 A live DBMS table (SQL Server 2005, 2008, or 2012) with more than 50 records does not open correctly in a 
browser. All records after record #49 does not display. This happens only in Windows XP.

Resolution: Fixed.
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